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In This Guide…
The MS Application Guide presents the information you need 
to conduct the instrumental analyses for the Agilent MALDI 
Protein Identification Solution. In this guide you will learn:

• How to optionally fractionate peptides by liquid 
chromatography with MALDI plate spotting (LC MALDI)

• How to prepare and analyze samples by MALDI MS/MS

• How to analyze the resulting data with the Spectrum Mill MS 
Proteomics Workbench or the Mascot protein database 
search software

1 Overview of MALDI MS with the MALDI Protein Identification 
Solution

Get an overview of the entire process for optional peptide 
fractionation, MALDI MS analysis, and translation of spectra to 
protein identifications.

2 MALDI Sample Preparation and Manual Plate Spotting

Learn how to dilute peptide samples, mix them with MALDI 
matrix, and spot them onto a MALDI target plate.

3 Peptide Analysis with MALDI MS/MS

Follow the protocol to perform MALDI MS/MS analyses.

4 Optional LC MALDI

Learn how to fractionate peptides by reversed-phase liquid 
chromatography, and how to automatically spot the fractions 
onto a MALDI plate. 

5 Data Analysis with Spectrum Mill MS Proteomics Workbench

Follow a general Spectrum Mill workbench protocol to process 
MALDI MS/MS data to generate tables of protein 
identifications.
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6 Data Analysis with Mascot Protein Database Search

Learn how to use a Visual Basic script to export MALDI MS/MS 
data to Mascot format, and how to use Mascot protein database 
search.
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Agilent MALDI Protein Identification Solution
MS Application Guide
1
Overview of MALDI MS with the MALDI 
Protein Identification Solution

Optional LC fractionation and automatic plate spotting (LC MALDI) 2

Preparation for analysis (matrix addition and plate spotting) 2

Mass spectrometry 3

Data analysis 3

Figure 1 gives an overview of the matrix-assisted laser desorption/ionization 
(MALDI) mass spectrometric (MS) analysis portion of the Agilent MALDI 
Protein Identification Solution. The applicable chapters from this MS 
Application Guide are indicated adjacent to the workflow. You do the steps in 
this manual after you complete the sample preparation steps covered in the 
Sample Preparation Guide.

This guide describes how peptides are optionally fractionated by liquid 
chromatography Chapter 4), how they are mixed with matrix and spotted onto 
a MALDI plate (Chapter 2 and Chapter 4), and how they are analyzed by 
MALDI MS/MS (Chapter 3). This guide also describes how the MS/MS spectra 
are then searched against protein databases using either the Spectrum Mill MS 
Proteomics Workbench (Chapter 5) or Mascot (Chapter 6).

WARNING Before you begin, be sure you understand all safety considerations and have read all 
applicable material data safety sheets.
1Agilent Technologies



1 Overview of MALDI MS with the MALDI Protein Identification Solution
Figure 1 Workflow for MALDI MS steps of MALDI Protein Identification Solution

Optional LC fractionation and automatic plate spotting (LC MALDI)

When MALDI MS/MS analyses are performed to identify peptides, more 
proteins can be identified when there are fewer peptides per spot. Liquid 
chromatography (LC) is commonly used to fractionate peptides. This 
application guide describes an optional reversed-phase (RP) LC separation 
with matrix addition and real-time deposition of the LC run onto a MALDI 
plate. This technique is known as LC MALDI.

Preparation for analysis (matrix addition and plate spotting)

If you perform LC MALDI, the matrix addition and plate spotting are 
automated along with the LC separation, so you skip this step. Otherwise, you 
perform the matrix addition and plate spotting manually, as described here.

LC-MALDI

Spectrum Mill MS
Proteomics Workbench or
LC/MSD Trap + Mascot

MALDI MS/MS

Optional peptide
fractionation

Mass
spectrometry

Data analysis

From sample prepSee Sample Preparation Guide

Chapters 5 and 6

Chapter 3

Chapter 4

Chapters 2 and 4Matrix addition
and plate spotting

Preparation for
analysis
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Overview of MALDI MS with the MALDI Protein Identification Solution 1
To do this step manually, you first adjust the peptide samples to the proper 
concentration. Then you mix each one with a MALDI matrix solution and spot 
the mixture onto a MALDI plate. The MALDI matrix contains a chromophore 
that absorbs the laser energy and transfers it to the sample, aiding in 
ionization.

Mass spectrometry

The next step in the workflow is MALDI MS analysis. Following ionization in 
the PDF-MALDI source, the peptides enter the ion trap mass spectrometer 
(MS). The molecular weights of the peptides are determined by MS precursor 
ion scans. MS/MS scans are then triggered on selected precursor ions 
according to data-dependent acquisition rules that are established prior to the 
analysis. The MS spectra provide molecular weights of the peptides, while ion 
fragments in the MS/MS spectra provide amino acid sequence information.

Data analysis

The final step in the workflow is data analysis. A major challenge in 
proteomics research is analysis of the vast amounts of data that are generated. 
Often, thousands of MS/MS spectra must be converted to protein 
identifications. With the MALDI Protein Identification Solution, two different 
data analysis paths are possible. 

One path uses the Agilent LC/MSD Trap DataAnalysis software to prepare and 
export the MS/MS spectra to Mascot generic format. The exported mass list 
files are then searched using the Mascot protein database search engine. The 
searches are conducted sample-by-sample over the internet, or are automated 
via licensed Mascot Daemon software. The results are then tabulated manually 
or via software developed in the laboratory.

Another path uses the Spectrum Mill MS Proteomics Workbench to extract the 
MS/MS spectra from the raw data files, conduct the protein database searches, 
validate the results via a combination of automated and manual validation, 
and summarize the results in biologist-friendly format. The Spectrum Mill 
workbench allows data from the various sample fractions (e.g., gel spots) to be 
automatically consolidated, and permits ready sample comparison.
MALDI Protein ID Solution MS App Guide 3



1 Overview of MALDI MS with the MALDI Protein Identification Solution
4 MALDI Protein ID Solution MS App Guide



Agilent MALDI Protein Identification Solution
MS Application Guide
2
MALDI Sample Preparation and Manual 
Plate Spotting 

Agilent reagents and equipment 6

Storage 6

Safety 6

Procedure summary 7

Additional materials required 7

Protocol to combine samples with matrix 8

Protocol to spot samples onto target plate 10

To clean target plates 11

Troubleshooting 12

Tips 12

The MALDI Protein Identification Solution includes the matrix solution, 
dilution solvent, and target plate you need for successful analyses. This 
chapter describes how to adjust the concentration of your sample, combine the 
sample with matrix, and spot the target plate.

If you wish to fractionate your peptides prior to spotting them onto the MALDI 
plate, see Chapter 4, “Optional LC MALDI,” starting on page 29. In this case, 
you can skip the steps in this chapter since the matrix addition and plate 
spotting are integral parts of the LC MALDI procedure.
5Agilent Technologies



2 MALDI Sample Preparation and Manual Plate Spotting
Agilent reagents and equipment

To prepare samples for MALDI analysis, you need the following Agilent 
supplies:

Storage

Store the MALDI matrix (p/n G2037A) and MALDI Matrix Dilution Solvent 
(p/n G1974-85000) at 4 °C.

Prior to using the MALDI matrix (p/n G2037A), warm it to room temperature 
and mix well to ensure that all the matrix is in solution.

Safety

Table 1 MALDI sample preparation – available products

Part number Product name Product description

G2037A α-Cyano-4-hydroxycinnamic acid, 
3 x 3 mL

MALDI matrix, 6 mg/mL

G1974-85000 MALDI Matrix Dilution Solvent, 20 mL Solution of 75% (by volume) water, 
24.9% isopropyl alcohol, and 0.1% 
trifluoroacetic acid (TFA)

G1972-60025 Target plate Plate for MALDI sample spotting and 
analysis

WARNING When preparing samples for MALDI-MS/MS analysis, follow safety guidelines for 
handling biological and chemical materials and wear protective eyewear and 
gloves.

Always take proper precautions for handling and disposing of solvents and other 
chemicals. Consult the material data safety sheets supplied by the vendors.
6 MALDI Protein ID Solution MS App Guide



MALDI Sample Preparation and Manual Plate Spotting 2
Procedure summary

Additional materials required

The following is a list of materials for sample preparation and plate spotting:

• Adjustable micropipettors (0.5 to 1000 µL)

• Sample vials or tubes

• Vortex

• Centrifuge

The following are needed to clean MALDI plates per the Agilent procedure 
(page 11):

• Acetone

• Methanol

• Deionized water

• Ammonium formate

Figure 2 Procedure for MALDI sample preparation

Clean, dry target plate

Adjust peptide sample concentration
(0.1 to 1 pmol/µL)

Spot 0.5 µL onto target plate

Mix sample with matrix
(5 to 10 µL matrix + 1 to 2 µL sample)

Dilute matrix (1:4)

MALDI sample
preparation and
plate spotting
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2 MALDI Sample Preparation and Manual Plate Spotting
Protocol to combine samples with matrix

Step 1. Adjust peptide sample concentration

• Adjust sample concentration for optimal performance. Ideally, the peptide 
concentration should be about 0.1 to 1 pmol/µL before you dilute it in the 
matrix solution. 

Step 2. Dilute matrix

1 Obtain the following from the MALDI Protein Identification Solution kit:

• α-Cyano-4-hydroxycinnamic acid (p/n G2037A, 6 mg/mL)

• MALDI Matrix Dilution Solvent (p/n G1974-85000), which consists of 75% 
(by volume) water, 24.9% isopropyl alcohol, and 0.1% trifluoroacetic acid 
(TFA)

2 Dilute α-cyano-4-hydroxycinnamic acid matrix 1:4 with MALDI Matrix 
Dilution Solvent. 

• For example, combine 80 µL matrix solution + 240 µL MALDI Matrix 
Dilution Solvent.

• This gives a 1.5 mg/mL matrix solution, which translates to 1.25 mg/mL 
after you mix with sample.

NOTE Prior to using the MALDI matrix (p/n G2037A), warm it to room temperature and mix well to 
ensure that all the matrix is in solution.
8 MALDI Protein ID Solution MS App Guide



MALDI Sample Preparation and Manual Plate Spotting 2
Step 3. Mix samples with matrix

3 Combine a 5- to 10-µL aliquot of matrix and a 1- to 2-µL aliquot of peptide 
sample. 

4 Mix thoroughly by vortexing for at least 30 seconds.

5 Centrifuge.

6 Deposit up to 1 µL of the supernatant onto the target plate, as described in 
“Protocol to spot samples onto target plate”.

NOTE For most cases, a final matrix concentration of 1.25 mg/mL will provide good results. If you 
know your sample concentration or want to optimize MS response, adjust the matrix 
concentration as follows:

• For sample loading higher than 50 fmol, the final matrix concentration should be about 2 
mg/mL. 

• For sample loading from 1 to 50 fmol, the final matrix concentration should be about 1.25 
mg/mL. 

• For sample loading below 1 fmol, the final matrix concentration should be approximately 
0.7 mg/mL. 

Final matrix concentration refers to concentration in the mixture that is actually spotted 
onto the MALDI plate.

NOTE If you store pre-mixed samples between -20 °C and 4 °C, warm the tubes to room 
temperature and thoroughly re-mix prior to use. The best way to store samples with matrix 
is crystallized on a target plate.
MALDI Protein ID Solution MS App Guide 9



2 MALDI Sample Preparation and Manual Plate Spotting
Protocol to spot samples onto target plate

To spot premixed samples

1 Be sure that the target plate is clean and dry. For cleaning instructions, see 
“To clean target plates” on page 11.

2 Check that the target plate is placed on a flat surface. If the plate is not 
level, the spot could spread, reducing the effective sample concentration.

3 Use a micropipettor to draw 0.5 µL of sample + matrix into a disposable 
pipette tip. Carefully position the tip to 0.5 to 1 mm from the plate surface. 
Brace the pipettor (not your arm) with your other hand and angle the tip at 
about 60 to 90 degrees with respect to the plate. See Figure 3.

CAUTION Even if you have a cleaning procedure for another manufacturers’ MALDI plates, it is 
imperative that you use the Agilent cleaning procedure described on page 11.

Figure 3 Spotting samples: best arm position and distance from plate
10 MALDI Protein ID Solution MS App Guide



MALDI Sample Preparation and Manual Plate Spotting 2
4 Gently expel the liquid. Check that only the droplet, not the tip, touches the 
plate. If the tip is placed too high the droplet will spread. If the tip touches 
the plate a thick cluster of crystals will form in the middle of the spot, 
which destroys its homogeneity.

5 Allow the spots to air dry at room temperature.

6 Store the covered plate at room temperature.

To spot peptides that have not been premixed

1 Be sure that the target plate is clean and dry. For cleaning instructions, see 
“To clean target plates”.

2 Check that the target plate is placed on a flat surface. If the plate is not 
level, the spot could spread, reducing the effective sample concentration.

3 Use a micropipettor to deposit 0.3 µL of sample onto the target plate.

4 Inject 0.3 µL of matrix into the sample droplet. Be careful not to create an 
air bubble.

5 Allow the spot to air dry at room temperature.

To clean target plates

To avoid sample carryover, clean reusable target plates before you spot 
samples. This is especially important when you work with low-level samples.

To clean target plates: 

1 Submerge plates in acetone and sonicate for about three minutes.

2 Submerge plates in a solution of 1:1 methanol:deionized water with 50 mM 
ammonium formate (3 to 4 g/L). Sonicate for about three minutes.

WARNING Always take proper precautions for handling and disposing of solvents and other 
chemicals. Consult the material data safety sheets supplied by the vendors.

NOTE It is convenient to prepare extra 1:1 methanol:deionized water with 50 mM ammonium 
formate. Prepare 500 mL and store it in a capped bottle in the fume hood. You do not need to 
freshly prepare this solution each time. 
MALDI Protein ID Solution MS App Guide 11



2 MALDI Sample Preparation and Manual Plate Spotting
3 Submerge plates in deionized water and sonicate for about 3 minutes.

4 Submerge plates in methanol and sonicate for about three minutes.

5 Heat the plates in the PDF-MALDI source for 20 minutes each or with a heat 
gun to completely dry. 

6 Let the plates cool completely before spotting samples. 

Troubleshooting

For troubleshooting information, see the troubleshooting chapter in the 
manual you received with the PDF-MALDI source.

Tips

Spot uniformity For best results, MALDI requires uniform co-crystallization of a layer of 
sample and matrix on a target plate. Sample exposure to strong ionic 
detergents, formic acid and contaminants may inhibit good crystallization.

Vortexing and
centrifuging

You obtain the best sensitivity when samples are pre-mixed with matrix. Since 
samples are usually in an aqueous buffer and matrix is dissolved in organics, 
matrix and sample must be thoroughly vortexed and centrifuged prior to 
spotting. Matrix and sample mix quite slowly, so vortex for at least 30 seconds. 
Centrifuging eliminates air bubbles and pulls the sample to the bottom of the 
vial, increasing homogeneity. 

Peptide
concentration

Avoid using higher sample concentrations than recommended; the final 
peptide concentration should be 0.1 to 1 pmol/µL before dilution in the matrix 
solution. Reducing the peptide concentration (not increasing it) frequently 
increases the signal intensity. 

Matrix dilution Use freshly diluted matrix solution whenever possible. Mix small volumes of 
solution as needed, or use refrigerated or frozen aliquots. Bring them to room 
temperature before mixing.

More information For more information, see the documentation you received with the 
PDF-MALDI source.
12 MALDI Protein ID Solution MS App Guide
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This chapter presents the protocol for the MALDI MS/MS analysis. You can 
acquire the data either manually or automatically. For manual operation, you 
analyze one spot at a time and you must be present to start the next sample. 
For automatic operation, you establish settings to run a series of spots without 
further intervention. For more details on operating the MALDI MS/MS system, 
see the documentation you received with the PDF-MALDI source and the 
LC/MSD Trap.
13Agilent Technologies



3 Peptide Analysis with MALDI MS/MS
System components

The MALDI MS/MS system (Figure 4) for the MALDI Protein Identification 
Solution consists of:

• Agilent G1974A Pulsed Dynamic Focusing (PDF) MALDI Source 

• Agilent 1100 Series LC/MSD Trap XCT or XCT Plus

• Target software for control of the PDF-MALDI source

• LC/MSD Trap software 5.2 SR1

Laser compliance

The Agilent G1974A PDF MALDI Source is a Class 1 Laser Product and 
complies with 21 CFR 1040.10.

Figure 4 MALDI MS/MS system
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Peptide Analysis with MALDI MS/MS 3
Safety

The PDF-MALDI source is safe when operated properly. Always observe the 
following safety rules:

WARNING Never switch the power ON at the rear panel of the AP/MALDI PDF control unit 
before the source is completely installed, and the optical fiber is properly connected 
at both ends.

WARNING Whenever you detach or connect the optical fiber to the control unit or the source 
housing, make sure the power switch on the control unit is OFF.

WARNING The target plate will be hot when you remove it from the source. Be extremely 
careful not to burn yourself when you remove the plate.

WARNING Never defeat or bypass interlocks.

Never open the cover of the source control unit.

WARNING Use of controls or adjustments or performance procedures other than those 
specified herein may result in hazardous radiation exposure.

WARNING See the additional safety information in the documentation you received with the 
PDF-MALDI source and the LC/MSD Trap.
MALDI Protein ID Solution MS App Guide 15



3 Peptide Analysis with MALDI MS/MS
Procedure summary

The following summarizes the protocol for MALDI MS/MS.

Figure 5 MALDI MS/MS procedure

Start the Target software

Load or set up the LC/MSD Trap
method

Set Target software parameters

Fill in sample information in
LC/MSD Trap software

Load the MALDI sample plate

Select sample(s) to analyze

System
preparation

Sample
analysis

Run the sample(s)
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Peptide Analysis with MALDI MS/MS 3
PDF-MALDI ion source operation 

Step 1. Start the Target software

1 Review the safety rules for the PDF-MALDI ion source. See the 
documentation you received with the source.

2 Close the PDF-MALDI source.

3 Turn on the PDF-MALDI source control unit.

4 Start the Target software.

5 Wait until initialization is completed and the Target software status field 
indicates Ready. 

Figure 6 shows the main screen for the Target software.

Figure 6 Main Target program screen

Sample spot selector

Center button moves the
target to the center of the spot

Arrows position the sample
under the laser spot

PDF-MALDI status

Operation mode selector
(Manual/Auto Sequence)

Play

Pause

Stop

Laser

Raster 

Spiral

(start)

motion fire

Laser fire indicator

Select or clear all spots

motion
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3 Peptide Analysis with MALDI MS/MS
Step 2. Set the LC/MSD Trap parameters

1 Start the LC/MSD Trap control software.

2 Load the appropriate method. To create a method, see settings under 
“Settings for MS/MS analysis with LC/MSD Trap XCT or XCT Plus” on 
page 24.

Step 3. Load the target plate

1 Open the PDF-MALDI source.

2 Insert the target plate.

3 Close and lock the source. Verify that you hear the two halves of the source 
click together.

Step 4. Run the samples

• If you will run samples manually one spot at a time, go to “To acquire data 
manually” below.

• If you will run samples in an automated sequence, go to “To acquire data 
automatically” on page 20.

To acquire data manually

Do this step only if you want to acquire your data in manual mode.

1 Select the Sample Info tab in the LC/MSD Trap Control window and fill in 
sample information.

2 In the Target software, if the Auto Sequence button is activated, click to 
deactivate it. 

3 Set the Target software parameters:

a From the Target main screen, choose Settings > Set Parameters.

b Establish settings as described in “Target program settings” on page 23.

4 On the Target software main screen, click buttons to activate the following:

• Laser fire 

• Spiral motion  

5 Select sample to analyze.
18 MALDI Protein ID Solution MS App Guide



Peptide Analysis with MALDI MS/MS 3
a Click the sample position on the Target main screen sample map.

b Verify via the Video Capture imaging system that the target plate moves 
to this sample position and stops near its center.

c Double-click the spot center to position the laser on the spot. 

6 Start the LC/MSD data acquisition by clicking the green arrow at the top of 
the LC/MSD Trap Control software window.

7 Click the Play (start) button in the Target window to start the laser firing. 

8 After data acquisition is complete, click the Stop button in the Target 
software to stop the laser fire. 

The LC/MSD Trap will stop automatically when the method runtime is 
reached. If you want to manually stop the analysis, click the Stop button in 
the Trap control software. 

9 Repeat step 5 through step 8 for each sample to analyze.

10 After all samples have been acquired, click Standby in the instrument 
control window.

11 In the Target software, click the Stop button to stop the PDF-MALDI 
operation. 

12 Open the target flange and wait a few minutes for the plate to cool, then 
with gloves on, carefully remove the target plate.

NOTE After you click Play, you can still adjust the position of the sample plate. For fast 
adjustment, view the Video Capture window and double-click the spot center. For slower 
adjustment, click the arrows on the Target main screen.

You can also turn the laser and spiral motion on and off by clicking the appropriate buttons 
on the Target main screen.

WARNING The target plate will be at 80 °C. Be extremely careful not to burn yourself when you 
remove the plate.
MALDI Protein ID Solution MS App Guide 19



3 Peptide Analysis with MALDI MS/MS
To acquire data automatically

Do this step only if you analyze your samples in automated mode.

1 Make sure that the cable has been installed between the External Control 
connector on the rear panel of the PDF-MALDI source control unit and the 
Remote and Aux Port connectors on the LC/MSD Trap. 

2 In the LC/MSD Trap Control software, enable remote control:

a Select the Mode tab.

b Click the Configure... button.

c Set up the remote control as shown in Figure 7.

3 Select the Sample Info tab in the LC/MSD Trap Control window and fill in 
sample information, similar to what is shown in Figure 8.

Figure 7 Settings for remote control 
20 MALDI Protein ID Solution MS App Guide



Peptide Analysis with MALDI MS/MS 3
4 In the Target software, click to activate the Auto Sequence button. 

5 Set the Target software parameters:

a From the Target main screen, choose Settings > Set Parameters.

b Establish settings as described in “Target program settings” on page 23.

6 On the Target software main screen, click buttons to activate the following:

• Laser fire 

• Spiral motion  

7 Select samples to analyze. 

a In the Target software main screen, click Clear All or Select All.

b Click one of the sample positions you wish to run.

c Select the remaining samples.

• Use the Shift key to select a contiguous group of samples.

• Use the CTRL key to select (or clear) a non-contiguous group of samples. 

8 In the Target software, click the Play button to start the data acquisition. 

Figure 8 Sample information example

NOTE Regardless of the order that samples are selected, samples are analyzed from left to right, 
starting from the top to the bottom row.
MALDI Protein ID Solution MS App Guide 21



3 Peptide Analysis with MALDI MS/MS
9 If you selected the Manual centering method, you will see the message 
“Waiting for user’s input.” This mode requires user verification of spot 
centers. 

a Observe the Video Capture image and double-click the spot center to 
re-center the spot. (Although you will not see confirmation, the software 
remembers the spot center.)

b Verify that the plate moves to the next spot. 

c Repeat steps a and b.

10 After all samples have been acquired, click Standby in the instrument 
control window.

11 In the Target software, click the Stop button to stop the PDF-MALDI 
operation. 

12 Open the target flange and wait a few minutes for the plate to cool, then 
with gloves on, carefully remove the target plate.

NOTE When the data acquisition is complete for the first sample, the laser will stop firing and the 
target will move to the next sample spot. This process will repeat until all samples are 
analyzed, or until you click the Stop button. 

On the sample map in the Target software main screen, a solid color indicates a sample that 
has already been analyzed, while a blinking color indicates a sample that is currently being 
analyzed.

WARNING The target plate will be at 80 °C. Be extremely careful not to burn yourself when you 
remove the plate.
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Peptide Analysis with MALDI MS/MS 3
Target program settings

General tab

Use the settings that were determined at installation. These are loaded 
automatically each time you start the software.

Sample Plate tab

Target Position
Offset

If the typical center position is not physically at the center of a target spot, 
change the X and Y values. Click Apply. Then check the four corner positions of 
the target plate and adjust the offsets if necessary. You may need to 
compromise slightly to align all the corners equally well. 

Plate Format Standard 96 

Spiral Motion tab

Use defaults if your spots contain 0.5 to 1.0 µL of combined sample and 
matrix. If you performed LC MALDI or manually deposited larger or smaller 
volumes, adjust for the spot size you deposited. 

Raster Motion tab

Use defaults

PDF tab

PDF On Check box marked

PDF Delay The optimum PDF delay is established at installation and subsequently 
remains unchanged.

Auto Sequence tab

External Timing Selected

Synchro pulse
duration

500 ms
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3 Peptide Analysis with MALDI MS/MS
Centering
Method.

• Select Geometry if you use an automated, precisely controlled spotter (such 
as LC MALDI) and all your spots are in the same position in each sample 
cell.

• Select Manual if you wish to manually determine the center of each spot.

Settings for MS/MS analysis with LC/MSD Trap XCT or XCT Plus

Mode

Scan mode Ultra scan 

Segments Segment 1 end time 0.25 min; segment 2 end time 7 min

Tune

Source PDF-MALDI (positive)

Vcap 3000 V

Drying gas flow 5.0 L/min 

Dry gas
temperature

325 °C 

Skim1 40 V

Capillary exit 200 V

Oct 1 DC 12.0 V

Oct 2 DC 3.2 V

Trap drive 110 V

Oct RF 200 V

Lens 1 -5 V

Lens 2 -60 V

CAUTION If you have not calibrated the ion trap recently, see “To calibrate the MS” on page 27.
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Block voltages Mark the check box for Follow values on Page Tune/Expert.

ICC values

Target 200,000 for XCT; 500,000 for XCT Plus

Maximum
accumulation

time

535 ms (corresponds to 6 laser shots)

MS scan range 400 to 2200 m/z

Averages Segment 1 uses 4 averages; segment 2 uses 8 averages

MS/MS fragmentation conditions

Auto MS(n) 2, enabled for segment 2 only

Fragmentation
amplitude

1.50 V

Precursor
selection

Include 600 to 2200 m/z

Number of
precursor ions

3 (Set to a smaller number if your spots are less than 0.5 µL in total volume.) 

SPS Enabled

Threshold
absolute

200 counts

Threshold relative 2%

SmartFrag On, 30-200%

Active exclusion On, exclude after 1 spectrum, release after 20 min

Advanced Auto MS(n) parameters

MS(n) averages 16

Isolation width 4.0

Use values from
MS scan

Yes

Use ultra scan Yes
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3 Peptide Analysis with MALDI MS/MS
Troubleshooting

For troubleshooting information, see the troubleshooting chapter in the 
manual you received with the PDF-MALDI source.

Tips

MS stop time You can adjust the MS stop time for your sample complexity. The protocol 
specifies 7 minutes, but a less complex sample may require only 3 to 4 
minutes. A more complex sample may require 15 to 20 minutes and a larger 
volume spotted.
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To calibrate the MS

Calibrate the ion trap mass spectrometer as directed in the Orthogonal 
Nanospray Ion Source User’s Guide or the LC/MSD Trap Installation Guide.

• Use the ESI tuning mix (G2431A).

• Use the electrospray source or the orthogonal nanospray source.

• Be sure to check the ion trap mass axis calibrations (scan, isolation and 
fragmentation).

• Calibrate the detector gain. In MSD Trap Control, click the Calibration tab, then 
the Detector button.

You should calibrate the MS if:

• This is the first time you are using it.

• You have not calibrated for 30 days.

• You observe mass shifts or other problems indicating the need to calibrate. 

• Your background seems unusually low, which indicates aging of the 
detector.

CAUTION The detector ages faster and must be calibrated more frequently when it is new.

NOTE Use a MALDI analysis of a standard protein digest to track performance of the MS. If you 
observe mass shifts or other performance inconsistencies, recalibrate the MS. 
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3 Peptide Analysis with MALDI MS/MS
To shut down the MALDI MS/MS system

To shut down the system, do the following at the end of your sample sequence:

1 After all samples have been acquired, click Standby in the LC/MSD Trap 
Control window.

2 In the Target software, click the Stop button to stop the PDF-MALDI 
operation. 

3 Open the target flange and wait a few minutes for the plate to cool, then 
with gloves on, use needle nose pliers to carefully remove the target plate.

WARNING The target plate will be at 80 °C. Be extremely careful not to burn yourself when you 
remove the target plate.
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This chapter describes LC MALDI, which is peptide fractionation by 
reversed-phase liquid chromatography, followed by real-time spotting onto a 
MALDI plate. For MALDI MS/MS analysis, you get best results if you have no 
more than two to three proteins per spot. This becomes even more critical if 
your proteins vary widely in concentration. If you have 1D gel bands from a 
fairly complex sample, you need to further fractionate the sample to reduce 
the sample complexity. LC fractionation is useful for this purpose. This 
chapter outlines an optimized method that includes online matrix addition 
and MALDI plate spotting.
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4 Optional LC MALDI
System components

Figure 9 Micro fraction collector/spotter and interface to MALDI MS/MS system

Fractionation/spotting system

• Agilent 1100 Series nanoflow pump with micro vacuum degasser

• Agilent 1100 Series thermostatted micro well-plate autosampler

• Agilent 1100 Series thermostatted column compartment with micro 
2-position/6-port valve (optional; used if you want to control the 
temperature of the column or use more than one column)

• Agilent 1100 Series diode array detector (DAD) with 80-nL flow cell

• Agilent 1100 Series thermostatted micro fraction collector/spotter

MALDI MS/MS system

• Agilent 1100 Series LC/MSD XCT or XCT Plus 

• Agilent PDF-MALDI source

• Agilent ChemStation A10.02 software

• Agilent LC/MSD Trap software version 5.2

• Agilent software for the control of the PDF-MALDI source
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Accessories for online matrix addition

To perform the online matrix addition, you need

• Syringe pump, KDS 200 or equivalent

Note that the syringe pump is not supplied by Agilent. The KDS 200 pump 
from KD Scientific (www.kdscientific.com/Products/KDS200/kds200.html) 
is recommended because you can control it via external contacts. External 
control allows you to turn the flow of matrix solution off and on depending 
on whether you are actually spotting. 

• Agilent Online Matrix Kit for MALDI Spotting (G1364-68706)

The contents of the kit are listed in Table 2. 

Note that the kit contains an External Contact BCD Board to control the 
syringe pump, as well as a cable to connect the KDS 200 syringe pump.

For more information on setting up online matrix addition, see the 
documentation you received with the micro fraction collector/spotter.

Table 2 Online Matrix Kit for MALDI Spotting (G1364-68706)

Item Part number

External contact BCD board kit G1351-68701

Cable, BCD board to KDS syringe pump 5181-1536

PEEK coated fused silica capillary, 550 mm x 125 µm G1375-87318

Needle, LL, 22/51/3, 2/pk 5183-4614

Syringe, ¼-28, 1 mL 5181-1541

Micro-connector, T-type 5042-8519

Union, ¼-28 to Luer 5042-8518

Adapter body, 10-32 to ¼-28 5042-8517
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4 Optional LC MALDI
Safety

See the manuals that you received with the 1100 Series modules for additional 
safety precautions.

Procedure summary

Schematic overview

Figure 10 shows a plumbing diagram for micro fractionation/spotting with 
online matrix addition. 

Figure 10 Schematic for micro fractionation/spotting with online matrix addition

WARNING Always take proper precautions for handling and disposing of solvents and other 
chemicals. Consult the material data safety sheets supplied by the vendors.
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Summary of steps

1 Separate tryptic peptides with a C18 nanobore column. 

2 Add matrix solution to column effluent.

3 Spot column effluent plus matrix solution onto MALDI plate. Adjust the 
number of fractions (spots/min) to meet your separation needs. Use Table 3 
as a guide. 

4 Transfer the MALDI plate to the MALDI MS/MS system.

5 Analyze the fractions using the protocol described in Chapter 3, “Peptide 
Analysis with MALDI MS/MS,” starting on page 13.

More details

For more details, see the application note entitled “Coupling of nano-LC to 
MALDI mass spectrometry – Real-time LC run mapping on a MALDI plate,” 
Agilent publication number 5989-1479EN.

Table 3 Spotting rate for peptide mixtures of increasing complexity*

Sample complexity Goal Spots/min nL/spot† Number of spots

Subcellular fraction or 
1D gel band

Reasonable number of 
proteins identified 
with shorter analysis 
time

2 400 40

Subcellular fraction or 
1D gel band

Maximum number of 
proteins identified

4 200 80

Whole cell lysate, 
sera, or fractions from 
these

Reasonable number of 
proteins identified 
with shorter analysis 
time

8 100 160

* Assumes LC conditions from “Protocol for micro fractionation/spotting” on page 35

† LC effluent only; same amount of matrix solution is added online
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Additional materials required

In addition to the 1100 Series modules, you need the following:

• Accessories for online matrix addition (see page 31)

• Water, HPLC grade (18 megohm) - Agilent p/n 8500-2236 or equivalent

• Acetonitrile, HPLC grade - Agilent p/n G2453-85050 or equivalent

• Trifluoroacetic acid (TFA), sequencing grade 

• α-Cyano-4-hydroxycinnamic acid (α-CHCA) - Agilent p/n G2037A or 
equivalent

• Isopropyl alcohol, HPLC grade

• Acetic acid
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Protocol for micro fractionation/spotting

Column Agilent ZORBAX 300SB-C18, 0.10 mm x 150 mm, 3.5 µm particle size, p/n 
5065-9910

Nanoflow pump A = water + 0.05% TFA; B = 90% acetonitrile + 0.05% TFA in water

Column flow 800 nL/min

Primary flow 500 to 800 µL/min

Gradient See Table 4.

10

Stop time 70 min

Post time 15 min

Injection volume Up to 6 µL (For a larger injection, increase the hold time at the beginning of 
the gradient and increase all times in the gradient table accordingly.)

Injector bypass After 10 min

Diode-array
detector (DAD)

210 nm +/- 8 nm, reference 360 nm

DAD flow cell 80 nL

Matrix 2 mg/mL α-CHCA in 50% isopropyl alcohol / 49% water / 1% acetic acid

Matrix flow
(syringe pump)

800 nL/min

Table 4 Gradient for micro fractionation/spotting

Time (min) % B

0 5

10 5

12 15

52 65

55 85

60 85
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4 Optional LC MALDI
Micro fraction
collector/spotter

Time-based spotting onto Agilent MALDI plates between 14 and 34 minutes 
during the LC run with spotting rate chosen from Table 3 on page 33

Liquid contact
adjustment

2

Contact control
distance

0.5 mm (You may need to adjust depending on flow rate and how you did the 
plate calibration.)

Fraction collector
thermostat

20 °C

External contact
control

Open at 0 min; close at 12 min; open at 34 min. (Enter these settings in the 
dialog box for the 1100 module in which you installed the external contact 
control board. These settings close the contact and start the matrix flow two 
minutes before the start of plate spotting.)

Bottom-sensing On, 0.9 mm offset for plastic conical micro-vials (Agilent p/n 9301-0978) 

Troubleshooting

Problem Cause Solution

LC column plugs 
frequently.

Particles from biological 
samples

Filter or use Agilent Spin Filters (p/n 5185-5990) to remove particulates.

If your column is plugged, you can sometimes recover by backflushing 
the column or replacing the screen at the head of the column. Check 
your column information sheet for the part number for the screen.

MALDI spots are not 
reproducible in size 
and shape.

Liquid contact 
adjustment not set 
properly

Set the liquid contact adjustment on the micro fraction collector/spotter 
to 2. The liquid contact adjustment is the ratio of LC pump flow + matrix 
flow to LC pump flow.

Capillary tip not properly 
positioned relative to 
MALDI plate

Perform a position accuracy calibration for MALDI targets. See the 
manual you received with the micro fraction collector/spotter.

Contact control 
distance not set 
properly (see Figure 11)

Adjust the contact control distance. You will find this setting in the 
configuration dialog box.
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Figure 11 A bad LC MALDI spot formed when the contact control distance was set too 
low, and a good spot shown after increasing this distance

For additional troubleshooting tips, see the manuals you received with the 
modules in your micro fractionation/spotting system.

Spots are skipped on 
the MALDI target.

Liquid contact 
adjustment not set 
properly

Set the liquid contact adjustment on the micro fraction collector/spotter 
to 2. 

Capillary tip not properly 
positioned relative to 
MALDI plate

Perform a position accuracy calibration for MALDI targets. See the 
manual you received with the micro fraction collector/spotter.

Contact control 
distance not set 
properly 

Adjust the contact control distance. You will find this setting in the 
configuration dialog box.

MALDI crystals are 
not homogeneous.

Matrix dissolved in 
wrong solvent

Be sure to use 50% isopropyl alcohol / 49% water / 1% acetic acid.

MALDI plate not at the 
correct temperature

Set the temperature control on the micro fraction collector/spotter to 
20 °C.

The first few MALDI 
spots do not 
crystallize well.

Salts from biological 
samples

Use Agilent Cleanup Pipette Tips (p/n 5188-5239) to remove salts, or 
start spotting after the column void volume.

Problem Cause Solution

Bad Good
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Tips

Plate spotting
rate

Optimize the plate spotting rate for the complexity of your samples. For less 
complex samples, collect fewer spots/minute. For more complex samples, 
collect more spots/minute or run a shallower gradient for better separation. 
See guidelines in Table 3 on page 33. More spots require additional analysis 
time, but translate to additional peptides and proteins identified.

Sample/matrix
crystallization on

MALDI plate

For optimum MALDI analysis, be sure your crystals are uniform in number 
and size over the entire MALDI spot. Two factors are important to achieve this 
goal.

• Solvent used for the matrix solution: The recommended solvent, 50% 
isopropyl alcohol / 49% water / 1% acetic acid, was chosen to minimize the 
effects of the changing solvent composition produced by the LC gradient. 
Other solvents may give poor results.

• Rate of droplet drying: This is regulated by the temperature of the micro 
fraction collector/spotter. For best results, set this to 20 °C.

Diode-array
detector

Use the diode-array detector to monitor and optimize the peptide separation.

Adjusting
analysis for spot

size

• For spots that are smaller than 0.5 µL or larger than 1.0 µL, adjust the Spiral 
Motion settings in the Target software. 

• For spots that are smaller than 0.5 µL, use the Trap Control software to 
reduce the analysis time for the MS/MS segment.
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This chapter provides a general protocol and tips for processing your data 
with the Spectrum Mill MS Proteomics Workbench. If you do not have the 
Spectrum Mill workbench, proceed to Chapter 6.

The Spectrum Mill workbench is a comprehensive software package that starts 
with raw mass spectral data files and provides tools to rapidly convert these 
to tables of protein identities. This software includes modules for extraction of 
high-quality spectra from raw data files, rapid protein database search of MS 
or MS/MS spectra, data review and validation, and results summary for single 
samples or groups of samples that span complex studies. The software accepts 
data from multiple vendors’ instrument types in multiple file formats. Both 
public and proprietary databases are supported.

The Spectrum Mill workbench provides a means to segregate search results 
that contain a valid interpretation of an MS/MS spectrum from those that do 
not. Results that are validated can be summarized in a results table. Results 
that are not validated can then be subjected to subsequent rounds of searches 
(against other databases or in homology mode, for example). This iterative 
approach allows for efficient processing that can be customized to the needs of 
the study.
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Procedure summary

Figure 12 Summary of iterative processing with Spectrum Mill workbench

Figure 12 shows the general procedure for data analysis with the Spectrum 
Mill workbench. The following summarizes the process:

1 Copy or move data to the Spectrum Mill server.

2 Preprocess the raw data files with the Data Extractor.

3 Search a database, preferably a species subset database for the first search.

4 Autovalidate the results with the highest scores. (Validation means that the 
proposed database match is accepted as the correct match for the MS/MS 
spectrum.)

5 Manually review and validate additional results.

6 Search the spectra that have not been validated:

• In homology mode or no enzyme mode against previous protein hits
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Data Analysis with Spectrum Mill MS Proteomics Workbench 5
• In identity or homology mode against a different database

7 Continue to perform iterative cycles of database search and validation to 
identify as many proteins as desired.

Protocol for data processing with Spectrum Mill workbench

The following protocol describes how to efficiently process MALDI MS/MS 
data with the Spectrum Mill workbench. The protocol assumes that the goal is 
to identify as many proteins as possible. If your study does not require this, 
you may omit some steps (those between step 5 and step 10). For details on 
use of the Spectrum Mill workbench, see the manuals and online help you 
received with the product.

1 Copy or move the raw MALDI MS/MS data files to the Spectrum Mill server.

• Be sure to set up a directory structure on the server that will make it 
easy to summarize and compare your results. See “Tips” on page 44.

2 Extract the data.

• Be sure to set the correct cysteine modification.

• Set Sequence tag length to -1. (This turns off the sequence tag filter.) 

• Set Merge scans with same precursor m/z to 600 sec, or long enough to cover 
the entire analysis time for a spot. 

3 Do the first database search. 

• Use a database subset (e.g. mammals). 

• Search in identity mode.

4 Autovalidate in Protein Details mode, then (optionally) in Peptide mode (using 
default settings).

5 Manually validate (down to score of 6, SPI 50 for simple sets). 

• Depending on the size of the data set, it may be easiest to do this in 
batches (i.e., first score > 8, then score >6).

6 Go to Tool Belt and save the results as a *.res file.

• Be sure to indicate the database you searched since this maps to 
accession numbers.

7 Do the next database search. Search either a database subset (e.g. 
mammals) or previous results. Search in the following modes with 
autovalidation and manual validation between each set of conditions:
MALDI Protein ID Solution MS App Guide 41



5 Data Analysis with Spectrum Mill MS Proteomics Workbench
• Multi-homology mq or mqsty (if phosphorylation is expected)

• No enzyme mode (to find non-specific cleavages for proteins already 
identified)

• Using C- or N-terminal modifications if they are expected for the species

• If sample was exposed to urea, search for carbamylation as N-terminal 
modification and search in multi-homology kmqsty mode.

8 When you think you are done, list sequence-not-validated spectra in Protein 
Details mode and look for proteins with multiple peptides. These may 
represent legitimate proteins at low levels. Re-examine the spectra to 
confirm.

9 Optional: Search again using a larger database (entire database or larger 
subset). This is most important when the original subspecies is not 
well-represented in the database. Autovalidate and manually validate.

10 Check statistics in Tool Belt. If there is a significant number of unmatched 
filtered spectra, continue searching.

11 When you have gained enough information from your data, summarize the 
results. See “To summarize data” on page 43.
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To summarize data

When you summarize data with the Protein/Peptide Summary page, remember 
that you can:

Validate results For Mode, select Peptide, Protein Details, Protein - Single Peptide ID, or Protein - 
Sample Centric Rows Details.

Compare results
across samples

For Data Directory, select more than one sample folder.

Evaluate
fractionation

For Mode, select Protein-Peptide Distribution Columns.

Do light/heavy
calculations

Under Review Fields, mark the L/H check box and select the site of the 
light/heavy modification.

Print results 1 Enable Print background colors and images in Internet Explorer. Select Tools > 
Internet Options.... Click the Advanced tab and mark the check box for Print 
background colors and images.

2 Select File > Page setup... to set the page to landscape mode.

3 Click in the frame you wish to print.

4 Select File > Print Preview....

5 At the top of the Print Preview window, select Only the selected frame.

6 Click the Print... button.

Import data into
Excel, Synapsia

Informatics
Workbench, or

LIMS

1 Mark the Excel Export check box.

2 Click the Summarize button.

3 Check that you see a display with two buttons, one to upload to LIMS and 
another to display the file.

4 Do one of the following:

• To import the data into Excel, import as semicolon-delimited data.

• To import the data into Synapsia, see the Synapsia online help. Be sure 
to copy and paste into the Synapsia Import Data screen only the bold 
portion of the Upload Path from the Spectrum Mill screen. 

• To upload to LIMS, see the Server Administration online help.
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Tips

Copying data to
server

To make it easy to compare data sets, set up the appropriate directory 
structure on the Spectrum Mill server. Whenever you want to compare 
samples in a set, you need to set up a subdirectory for each sample. This 
sample directory may contain data files from multiple gel spots. Here are some 
examples:

• If you analyze multiple spots from a single sample, transfer all the files to a 
single directory on the server.

• If you prepare another sample in the same way, or if you repeat the run on 
the first sample, transfer all these files to a second directory.

• If you conduct a differential expression study, transfer samples from one 
cell state into one directory and the second cell state into a second 
directory.

Extracting
spectra

When you extract your data, be sure to remember that you extract only one 
directory at a time.

Searching
spectra

Before you search a subset database, review the Spectrum Mill species 
definitions and modify if necessary. For the default species definitions, see the 
online help for the MS/MS Search page.

Validating results For efficient validation of MS/MS search results:

• Use the Autovalidation page to validate the highest-scoring results—those 
that do not require manual review. 

• Use the Protein/Peptide Summary page for manual review and validation of 
medium-scoring results.
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In this chapter you learn how to perform data analysis using the LC/MSD Trap 
DataAnalysis software and Mascot database search. Mascot from Matrix 
Science Limited is a search engine that uses mass spectra to identify proteins 
from sequence databases. Mascot searches can be performed free of charge at 
www.matrixscience.com. Optional Mascot Daemon software automates the 
searches, but can only be used with an in-house Mascot Server license.

If you have the Spectrum Mill MS Proteomics Workbench, disregard this 
chapter and read Chapter 5 instead.
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6 Data Analysis with Mascot Protein Database Search
Procedure summary

Figure 13 Data analysis with the LC/MSD Trap software and Mascot search

When you use Mascot, data analysis for protein digest samples consists of five 
steps:

1 Use Find Compounds to locate and hierarchically organize related MS and 
MS/MS spectra.

2 Use Mass List Find to label spectra with masses.

3 Perform (optional) charge deconvolution. 

4 Export spectra to Mascot format.

5 Perform Mascot database search.

The first four steps are automated via a Visual Basic script that you add to 
your LC/MSD Trap methods. Once you have generated a Mascot generic format 
(*.mgf) file from your mass spectral data, you conduct an online search on a 
single file at www.matrixscience.com, or an automated search using the 
optional Mascot Daemon software on an in-house server.

Locate spectra with Find
Compounds

Automate via Trap
DataAnalysis method
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Mass List Find
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Data Analysis with Mascot Protein Database Search 6
To use LC/MSD Trap Visual Basic script to export data to Mascot 

To activate the Visual Basic script

1 In MSD Trap Control, open the LC/MSD Trap method you created to do the 
MALDI MS/MS analysis of peptides.

2 Select Method > Add DataAnalysis Method Part. 

3 Select the DataAnalysis method Example DA Methods with Scripts\
Auto_MIS_MgfExport.ms.

4 Select Method > Save entire Method As to save the MALDI MS/MS method with 
the DataAnalysis part attached.

To change processing method parameters

The method Auto_MIS_MgfExport.ms includes:

• The Visual Basic script 

• Starting parameters for Find Compounds AutoMS(n), Mass List Find, 
Deconvolution, and Mascot Export Options

The script does not change or optimize the starting method parameters. If you 
change method parameters (i.e., based on recommendations from 
“Troubleshooting” on page 55), test and save your changes as follows:

1 Select Method > Run to execute the script again on your test data file. 

2 Select Method > Save As to save a new copy of the processing method.

To change the Visual Basic script

The Visual Basic script is shown in Figure 14. To change the script:

1 Select Method > Script.

2 Make the desired change. 

3 Save a new copy of the processing method by selecting Method > Save As.
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Figure 14 Visual Basic script to automate data analysis

For more information on modifying this script or writing new ones, see the 
following help:

• DataAnalysis Online Help (Help > Help Topics > Using processing methods and 
scripting) 

• Visual Basic Script Language Reference (Help > VBScript Language Reference)
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To deactivate the script

If you would prefer not to run this script automatically as part of your 
sequence, deactivate it in the LC/MSD Trap software:

1 Go to the MSD Trap Control screen.

2 Select Method.

3 Clear the Run Processing Script check box.

To use the MASCAT concatenator for sample fractions

MASCAT concatenates multiple *.mgf files for Mascot data-base search, 
enabling consolidated search of spectra from analysis of sample fractions (e.g., 
multiple gel spots). To use MASCAT: 

1 Click the MASCAT icon.

2 Select data files you wish to combine. See Figure 15 as an example.

3 Enter an output file path and name.

4 Click Concatenate.

5 Click Calculate Number of Queries and decide if the number fits within your 
time and computer memory constraints.

• If so, proceed to do the Mascot search (page 51).

• If not, go to step 6.

6 Regenerate the individual Mascot generic files using a higher threshold for 
compound finding and/or more stringent requirements for input spectral 
quality.

7 Repeat step 1 to step 5.
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Figure 15 MASCAT concatenator to combine *.mgf files from multiple sample fractions (e.g., gel spots)
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To use Mascot protein database search

1 Decide how you will do the search. The options are:

• Conduct an online search at www.matrixscience.com.

• Conduct an automated search using the optional Mascot Daemon 
software on an in-house server.

2 Set parameters for either type of search. 

• See Figure 16 and the explanations that follow.

• For more details, see the Mascot online help.

3 Click Start Search... to initiate the Mascot search.

4 View search results either immediately via your web browser, or later via 
email. 

Figure 16 Parameters for Mascot MS/MS Ions Search
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Database Search public databases at www.matrixscience.com, or search proprietary 
databases using an in-house server. Search a second database if your first 
choice fails to provide significant data.

Taxonomy For faster searches, select a species or group of species rather than All entries. 
Be aware that some databases do not rigorously classify taxonomy, so if you 
specify taxonomy you may obtain fewer legitimate hits. You may also miss 
homologous proteins from related species. If your search fails to give a result, 
try the Species information unavailable or All entries selections.

Enzyme Specify the enzyme used for protein digestion. If you are unsure, you can 
select None, but the search will take much longer because all cleavages must be 
considered.

Missed
cleavages

Unless your digestion is perfect, choose 1 or at most 2. You can choose larger 
numbers if you have confidence this is necessary, but larger numbers will 
increase search time and will increase the chance of false positives.

Fixed
modifications

These modifications are applied universally and add no additional search 
time.

Variable
modifications

Avoid specifying a large number without cause. These modifications are not 
applied universally and add significantly to the search time.

Peptide charge Select 1+, since MALDI ions are singly-charged.

Data file Select your *.mgf file from the folder where you saved the exported file.

Instrument Select ESI-Trap.
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To use Mascot Daemon

The optional Mascot Daemon software on an in-house server automates 
database searching. You set search parameters using the Mascot Daemon 
Parameter Editor, shown in Figure 17. Parameter entry is similar to that 
discussed in “To use Mascot protein database search” on page 51.

Figure 17 Mascot Daemon Parameter Editor

You set automation parameters using the Mascot Daemon Task Editor, shown 
in Figure 18. Some of these fields are discussed briefly below. Additional 
information is available via the Mascot Daemon online help.
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Figure 18 Mascot Daemon Task Editor

Schedule Schedule searches by time and date, or use the real-time monitor to run 
searches as Mascot generic files are written to a particular directory (e.g., by 
use of a Visual Basic script). 

Follow-up Schedule score-dependent follow-up.

Optional wild
card filename

Search for Mascot generic format files (*.mgf) only.
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Troubleshooting

Problem Cause Solution

Too few proteins 
identified

Default settings for 
LC/MSD Trap data 
analysis software not 
appropriate for sample

Check to see if the threshold for Find Compounds is set too high:
a In the data analysis navigation tree, scroll to the bottom of the 

Compound Mass Spectra node. You should observe a reasonable 
number of compounds for your sample.

b If this is not the case, select Method > Parameters.
c Click the Find tab.
d Click the AutoMS(n) subtab.
e Enter a lower number for the Compound detection, Intensity 

threshold.

Check to see if the retention time window for Find Compounds is set 
appropriately:
a Select Method > Parameters.
b Click the Find tab.
c Click the AutoMS(n) subtab.
d Set Retention time window [min] to 10. (Since there are no 

chromatographic peaks, you use the maximum setting.)

Check to see if the threshold for Mass List Find is set too high:
a Select Method > Parameters.
b Click the Mass List tab. 
c Make sure Apex is selected.
d Click the Apex subtab.
e Enter a smaller number for the Absolute intensity threshold.

Incorrect settings for 
Mascot search

See “To use Mascot protein database search” on page 51.

Chosen database did 
not give good results

Try searching a different database.

Default settings for 
LC/MSD Trap data 
acquisition software not 
appropriate for sample

See the troubleshooting information in the documentation you received 
with the PDF-MALDI source.
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Tips

Threshold for Find
Compounds

The intensity threshold for Find Compounds determines how many mass spectra 
are exported to Mascot. The appropriate threshold depends upon sample 
concentration and data acquisition parameters. To evaluate where to set the 
threshold, generate a total ion chromatogram containing all the MSn data (TIC, 
All MSn). Set the threshold to a level that includes at least half the MSn data 
points. The lower the threshold, the slower the data processing, but the better 
the chance for improved sequence coverage

Threshold for
Mass List Find

Once you have located correlated MS and MS/MS spectra using Find Compounds, 
check to make sure the mass peaks are labeled. If mass peaks are not labeled, 
they will not be exported to Mascot. Check a few of your lower-intensity 
MS/MS spectra. Zoom in to see if the masses are labeled. You need to zoom in 
to check because the software prevents the labels from overlapping on your 
screen. If you observe good spectra (many fragments at intensities greater 
than the parent ion), but the mass peaks are not labeled (even when you zoom 
in), lower the Absolute intensity threshold for Mass List Find.

Problem with sample 
preparation

See the troubleshooting information in the Sample Preparation Guide.

Noisy spectra 
exported to Mascot

In Trap DataAnalysis, set a larger value for Abundance cutoff [%] for 
deconvolution. (The % refers to percent of the most intense peak in the 
mass spectrum.)
a Select Method > Parameters.
b Click the Charge Deconvolution tab. 
c Click the Peptides/Small Molecules subtab.
d Set Abundance cutoff [%] to a higher value.

Problem Cause Solution
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